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ВВЕДЕНИЕ 
 

Цель лабораторной работы – познакомить учащихся с основными 
приёмами моделирования деформированного состояния рам и балок в 
среде профессионального пакета программ ANSYS [1-5]. 

Балка – это прямой стержень, имеющий в основном деформацию 
изгиба. 

Рама – это система связанных стержней, имеющих в общем случае 
деформации растяжения-сжатия, изгиба, сдвига и кручения. 

Расчёт балок и рам заключается в определении перемещений, де-
формаций, внутренних сил и моментов, напряжений, реакций опор. 

Программа ANSYS использует метод конечных элементов (МКЭ). 
Прочностной анализ балок и рам методом конечных элементов  произ-
водится путём разбивки тела на стержневые конечные элементы.  

Схема 3-х мерного стержневого конечного элемента постоянного 
сечения с двумя узлами, который позволяет моделировать изгиб с рас-
тяжением-сжатием и кручением, показана на рис 1. Направление мест- 

Р и с. 1. Стержневой конечный элемент 
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стержня, а оси y, z совпадали с главными центральными осями его по-
перечного сечения. 

Каждый узел стержневого элемента имеет 6 степеней свободы, об-
разующих вектор узловых перемещений элемента 

       Tjxixjyjziyizjzjyiziyjxixe UUUUUUU  , 

где  Uix, Ujx ,Uiy, Ujy, Uiz, Ujz - перемещения узлов по направлениям осей, 
iz, jz, iy, jy, ix, jx – углы поворота узловых сечений. 

Нагрузки в узлах, представляются вектором  

   Tjxixjyjziyizjzjyiziyjxixe MMMFMFMFMFFFF  , 
где Fix, Fjx ,Fiy, Fjy, Fiz, Fjz , Miz, Mjz, Miy, Mjy, Mix, Mjx  - узловые силы и 
моменты. 

При растяжении-сжатии стержневого элемента связь между пере-
мещениями Uix, Ujx и силами Fix, Fjx устанавливается по закону Гука[6]: 
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E – модуль упругости, S – площадь сечения стержня. 
Методами сопротивления материалов, используя техническую тео-

рию изгиба балок [6] и аппроксимируя изгибные перемещения стержня 
кубическим полиномом, можно получить зависимости 
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Jz – момент инерции сечения относительно оси z. 
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Jy – момент инерции сечения относительно оси y. 
Для кручения стержневого элемента по аналогии с растяжением-

сжатием можно записать 
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GJkp – жёсткость на кручение, G- модуль сдвига. 
Объединяя соотношения (1)-(8), получим матричное уравнение жё-

сткости для стержневого конечного элемента 
     eee FUK  ,                                                (9) 

где блочная матрица жёсткости стержневого элемента имеет вид 
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Если на стержневой конечный элемент действуют внеузловые на-
грузки (распределённые или сосредоточенные), то они заменяются  
эквивалентными узловыми силами  
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Компоненты этого вектора определяются как силы или моменты, 
противоположные реакциям, которые возникают от внеузловой нагруз-
ки при защемлении элемента в узлах. Уравнение (9) при наличии 
внеузловой  нагрузки заменяется на соотношение  

       q
eeee PFUK   .                               (11) 

Расчётные соотношения для всей балки или рамы получаются пу-
тём составления уравнений  равновесия для каждого узла модели в об-
щей системе координат, причём должны быть уравновешены как силы, 
так и моменты. Один узел имеет 6 степеней свободы, поэтому для мо-
дели с n узлами можно составить N=6n уравнений равновесия. Общая 
система уравнений равновесия для узлов модели с учётом равенств (11)  
преобразуется к виду 

      qPPUK  ,                                  (12) 
где 
 U  - общий вектор узловых перемещений модели размерности N; 

 K  - общая матрица жёсткости модели порядка NN, компоненты ко-
торой определяются через компоненты матриц жёсткости элементов 
путём суммирования их с одинаковыми индексами[1,2,4,5];  
 P  - общий вектор заданных внешних узловых сил и заданных внеш-
них узловых моментов; 
 qP  - общий вектор эквивалентных внешних узловых сил и моментов, 
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заменяющих внеузловые нагрузки. Компоненты  qP получаются сум-
мированием соответствующих элементных компонентов [1,2,4,5]. 

Граничные условия в перемещениях (связи) учитываются путём 

преобразования матриц  K  и    qPP   [1,2,4,5]. Связи должны исклю-
чать возможность перемещения рамы (балки) как твёрдого тела. 

В результате решения системы уравнений (12) находятся все узло-

вые перемещения  U . Через них с помощью соотношений (11) можно 

найти узловые силы и моменты  eF , действующие на любой конечный 
элемент. Далее можно построить эпюры внутренних сил и моментов 
для каждого элемента и методами сопротивления материалов найти де-
формации и напряжения [6]. 
 

1. ПРИМЕР МОДЕЛИРОВАНИЯ В ANSYS ДЕФОРМИРО-
ВАННОГО СОСТОЯНИЯ РАМЫ 

 

1.1. Постановка  задачи 
 

Конструкция, закрепления, нагрузки. 
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Р и с. 2. Расчётная схема рамы 
 

Р = 1000 H, (Р1=Рsin300=1000*0.5=500H, Р2=Рcos300=1000*0.866=866H). 
q =200 H/м, M = -1000 Нм. Материал сталь. Модуль упругости E=2*1011 

Па, коэффициент Пуассона =0,3. Требуется определить перемещения 
рамы, реакции опор, наибольшие напряжения в опасном сечении рамы. 

1.2.Моделирование задачи в интерактивном режиме 
 

Присваиваивание имени задаче и выбор типа анализа 
 

U.M > file > Change Jobname  [/FILNAM]=Rama   New log =   Y     > ok. 
Выбирается тип анализа: 

M.M > Preferenses >    Y     > structural > ok. 
 

Моделирование в препроцессоре 
 

Выбирается тип элемента-балка Beam 188: 
M.M > prepr > Element Type > Add/Edit/ > Add > Beam > 2 node 188, 
Elem. Type number = 1 > ok, окно Element Types >close. 
Выбирается сечение балки и задаются размеры: 
M.M. > Prepr. > Sections > Beam Common Sectns >Выбирается прямо-
угольник (рис 1)  B = 0.03,  H = 0.04 > ok. 
Задается тип материала и его свойства: 
M.M.> Prepr.> Materials Props > Materials Models >Structural (2 click ) > 
lenear (2 click ) > Elastic (2 click ) >Isotropic >EX = 2.E11  (модуль упру-
гости),  PRXY=0.3 (коэффициент Пуассона) >ok. Окно Detine Materials 
закрывается: Material > Exit. 
Сохраняется модель в файле Rama.db :    Ans.Toolbar > SAVE_DB. 
Построение твердотельной модели: 
Строятся 5 ключевых точек, 5-я точка вспомогательная для ориентации 
элементов. 
M.M. > Prepr. > Modeling  > Create  > Keypoints > in Active CS > 

                                                  NPT= 1 > X,Y,Z = 0.0     0.0 >Apply, 
                                                  NPT= 2 > X,Y,Z = 0.0     3.0 >Apply, 
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                                                  NPT= 3 > X,Y,Z = 2.0     3.0 >Apply, 
                                                  NPT= 4 > X,Y,Z = 2.0     2.0 >Apply, 
                                                  NPT= 5 > X,Y,Z = 1.0     0.0 >ok. 

Строятся линии. 
M.M. > Prepr. > Modeling > Create > Lines > Lines > Straght Lines > 

                         Pick точка 1 >.pick точка 2 (строится линия №1), 
                         Pick точка 2 >.pick точка 3 (строится линия №2), 
                        Pick точка 3 >.pick точка 4 (строится линия №3), 
                        на панели Creat Str.line >ok. 

Присваиваются атрибуты твердотельной модели: 
M.M. > Prepr. >Meshing > Mesh Attribut >All Lines > MAT = 1, TYPE= 1 
Beam188, SECT = 1> Pick Orient Keyp. > Y.ok > Pick точка 5 > панель 
Line Attr > ok. 
Разбивка линий на элементы длиной 0.5 м: 
M.M.>Prepr.> Meshing > Size Cntrl. > Manualsize >Lines > All Lines > 
size =0.5 > ok ( закрывается панель Elem.size). 
Создание конечноэлементной модели: 
M.M. >Prepr. > Meshing  > Mesh > Lines  > Pick линия 1,  pick линия 2, 
pick линия 3 > ok. Закрывается панель Mesh Lines. 
Сохранение модели:  ANS. Toolbar > SAVE_DB. 

 

Моделирование с помощью процессора Solution 
 

Указание процессору Solution типа анализа (можно пропустить т.к. 
данный случай анализа выполняется по умолчанию): 
M.M. > Solution > Analysis Type > New Analysis > ANTYPE = static > ok. 
Закрепление рамы: 
M.M. > Solution > Define Loads > Apply >Structural > Displasement > on 
keypoints > Pick точка 1 > apply (панель Apply U.ROT), Lab2 =  UX,  
VALUE = 0 > Apply, 
Pick точка 1 > apply ( панель Apply U.ROT), Lab2 =  UY,  VALUE = 0 > 
Apply, 
Pick точка 4 > apply панель Apply U.ROT) Lab2 = UY,  VALUE = 0 > ok. 
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Нагружение рамы сосредоточенной силой: 
M.M. > Solution > Define Loads > Apply > Structural > Forse > on Key-
points > 
Pick точка 2 > ok (панель Apply) > Lab = FX, VALUE = - 500 > apply > 
Pick точка 2 > ok (панель Apply) > Lab = FY, VALUE = - 866 >ok. 
Нагружение рамы сосредоточенным моментом: 
Отображаются номера узлов 
U.M.> Plotctrl >Nambering > Node Y ok. 
M.M. > Solution > Define Loads >Apply >Structural > Moment >on Node > 
Pick узел 5 > ok (панель Apply) > Lab = MZ, VALUE = - 1000 > ok. 
Нагружение рамы распределенной нагрузкой: 
Отображаются номера элементов: 
U.M.> Plotctrl >Nambering > Elem/Atr = Elem namb. [/NUM]=colors & 
numbers >ok.  
Прикладывается давление к каждому стержневому элементу (одинако-
вое давление можно приложить сразу ко всем элементам, выделив их с 
помощью команды Box на панели PRESS on Beams): 
M.M. >Solution > Define Loads >Structural >Apply > Pressure >On Beam > 
Pick элемент 7 > Apply (панель Apply) > Lkey= 1, VALI = - 200 > Apply, 
Pick элемент 8 > Apply (панель Apply) > Lkey= 1, VALI = - 200 > Apply, 
Pick элемент 9 > Apply (панель Apply) > Lkey= 1, VALI = - 200 > Apply, 
Pick элемент 10 > ok (панель Apply) > Lkey = 1, VALI= - 200 > ok. 
Сохранение модели:     ANS toolbar > SAVE_DB. 
Решение задачи: 
M.M. > Solution > Solve > Current LS >Просматривается и закрывается 
окно / STATUS > file > close >Закрывается окно > Solve  ok. 
Производится решение. 
Закрывается окно Information c текстом “Solution in done” > close. 
Сохранение модели:    ANS toolbar > SAVE_DB. 
Отменяется изображение номеров узлов, элементов и реакций: 
U.M.> Plotctrl >Nambering > Elem/Atr = Elem namb. [/NUM]=no numbers; 
Node No; Reaction on >ok.  
Изображение конечно-элементной модели (рис.3) сохраняется в файле: 
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U.M.> Plotctrl > Hard Copy > to file > формат JPEG > ok. 
 

Просмотр результатов с помощью постпроцессора 
 

Определение перемещений: 
M.M. > General Postproc.> Plot Results > Deform. Shape > Def+undef > ok.  
Изображение (рис.4) сохраняется в файле в рабочей папке: 
U.M.> Plotctrl > Hard Copy > to file > формат JPEG > ok. 

Р и с. 3. Конечно-элементная модель.         Р и с 4. Перемещения рамы 
 
Делается установка на объёмное изображение рамы: 
U.M. > Plotctrls > style > size and Shape > [/ESHAPE] =  Y  ( on) > ok. 
Объёмное изображение в изометрии: 
U.M. > Plotctrls > Pan, Zoom, Rotate > Iso. 
(Можно изменять изображения с помощью кнопок на правой панели). 
Определение наибольших эквивалентных напряжений по Мизесу: 
M.M. > General Post. > Plot Res. > Contour Plot > Elem. Solu >Stress > von 
Misess stress  > ok. 
Изображение (рис.5) сохраняется в файле: 
U.M.> Plotctrl > Hard Copy > to file > формат JPEG > ok. 
Увеличение масштаба для просмотра напряжений: 
U.M. > Plotctrls > Pan, Zoom > на диалоговой панели BOX ZOOM > 
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устанавливаем курсор-лупу рядом с местом наибольших эквивалентных 
напряжений (около узла 5) > pick > выделяем область просмотра > pick 
> видим увеличенный фрагмент (рис.6), уточняем наибольшее значение 
эквивалентных напряжений и место их действия (опасную точку). 
Изображение сохраняется в файле: 
U.M.> Plotctrl > Hard Copy > to file > формат JPEG > ok. 
Восстанавливаем масштаб изображения кнопкой Reset на панели Pan-
Zoom > закрываем панель > Cloze. 

 

Р и с. 5. Эквивалентные напряжения.           Р и с. 6. Эквивалентные напряжения 
                                                                                         в опасном сечении. 
 
Определение нормальных про-
дольных напряжений: 
M.M. > General Post. > Plot Res. > 
Contour Plot > Elem. Solu >Stress > 
X-components SX > ok. 
Увеличение масштаба для про-
смотра напряжений и сохранение 
в файле фрагмента поля нормаль-
ных напряжений в опасном сече-
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нии производится, как в предыдущей процедуре (рис.7). 
 

                                                                       Р и с. 7. Нормальные напряжения 
                                                                                     в опасном сечении. 
Построение эпюр нормальных сил и изгибающих моментов: 
M.M.> General Post. > Element Table > Define Table > Add > вводится 
Lab = NI > выбирается By sequence num > вводится SMISC,1 > Apply, 
Lab = NJ > выбирается By sequence num > вводится SMISC,14 > Apply, 
Lab = MI > выбирается By sequence num > вводится SMISC,2 > Apply, 
Lab = MJ > выбирается By sequence num > вводится SMISC,15 > ok > 
Close (закрывается  окно Element Table Data). 
Построение эпюры нормальных сил: 
M.M. > General Post. > Plot Res. > Contour Plot > Line Elem. Res. > в от-
крывшемся окне выбрать LabI = NI, LabJ = NJ > Fact Optional Scale fac-
tor =1 (масштаб эпюры) > no Def. Shape (недеформированная рама)> ok. 
В графическом окне появляется изображение эпюры (рис.8).  
Изображение сохраняется в файле: 
U.M.> Plotctrl > Hard Copy > to file > формат JPEG > ok. 
Построение эпюры изгибающих моментов: 
M.M. > General Post. > Plot Res. > Contour Plot > Line Elem. Res. > в от-
крывшемся окне выбрать LabI = MI, LabJ = MJ > Fact Optional Scale fac-
tor =1 (масштаб эпюры) > no Def. (недеформированная рама)> ok. 
В графическом окне появляется изображение эпюры (рис.9).  
Изображение сохраняется в файле: 
U.M.> Plotctrl > Hard Copy > to file > формат JPEG > ok. 



 14  

Р и с. 8. Эпюра нормальных сил                  Р и с. 9. Эпюра изгибающих моментов 
 

Определение реакций: 
M.M.> General Post. > List Res.> Reactions Solu > All items > ok. 
Сохранение появившейся таблицы реакций в файле: 
files > Save as > выбирается рабочая папка и указывается имя файла. 

Результаты расчёта реакций в ANSYS показаны в таблице 1. 
 

1.3 Аналитический расчёт реакций 
 

Используется схема, представленная на рис.2. Составляются урав-
нения равновесия плоской рамы, куда входят неизвестные реакции AxR , 

AyR , ByR : 

  030sin 0  Axkx RPF , 

  0230cos 0  ByAyky RRqPF , 

    0212330sin 0  MRqPFM BykA . 
 

Найденные в результате решения уравнений равновесия реакции 
приведены в таб.1. 

Таблица 1 
Реакции опор рамы 

 

xR , Н yR , Н Опора 

ANSYS Аналит. расчёт ANSYS Аналит. расчёт 
А 500.00 500.00 1316.0 1316.0 
В   -50.000 -50.000 

 
 

Вычисленные двумя методами реакции опор хорошо совпадают, 
что свидетельствует о правильности моделирования рассмотренной за-
дачи. 
 Эти реакции также хорошо согласуются с построенными програм-
мой ANSYS эпюрами нормальных сил и изгибающих моментов 
(рис.8,9). 



 15  

 
 
 

2. ПОРЯДОК ВЫПОЛНЕНИЯ ЛАБОРАТОРНОЙ РАБОТЫ 
 

1. Повторяется моделирование рассмотренной выше задачи. 
2. Моделируется индивидуальный вариант рамы, заданный преподава-

телем. Исходные данные берутся из таблицы 2 и рис. 10. Свойства 
материала и вид сечения задаются преподавателем. 

3. Аналитически рассчитываются реакции опор заданной рамы. 
4. Оформляется отчёт. 
 

3. ОФОРМЛЕНИЕ ОТЧЁТА. 
 

Отчёт должен включать следующие пункты. 
1. Постановка задачи.  

1.1. Силовая схема (конструкция, закрепления, силы). 
1.2. Исходные данные (величины сил, свойства материала). 
1.3. Что требуется найти? 

2. Короткое описание процедуры моделирования в ANSYS. 
3. Результаты решения задачи с помощью программы  ANSYS. 

3.1. Конечно-элементная модель. 
3.2. Схема перемещений рамы с указанием наибольшего смещения. 
3.3. Объёмное изображение рамы в изометрии. 
3.4. Поле эквивалентных напряжений по Мизесу на объёмном изо-
бражении рамы. 
3.5. Поле эквивалентных напряжений по Мизесу в опасном сечении 
рамы в увеличенном масштабе. 
3.6. Поле нормальных напряжений на объёмном изображении ра-
мы. 
3.7. Поле нормальных напряжений в опасном сечении рамы в уве-
личенном масштабе. 
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4. Расчёт реакции опор данной статически определимой рамы аналити-
ческим методом статики [7] с помощью уравнений равновесия и 
сравнение их с найденными в ANSYS. 

5. Таблица реакций. 
 

4. ЗАДАНИЯ ДЛЯ САМОСТОЯТЕЛЬНОЙ РАБОТЫ 
 

(1)                                                                   (2) 

(3 )                                                                   (4) 

 (5)                                                                  (6) 
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 (7)                                                                 (8) 

(9)                                                              (10) 

(11)                                                            (12) 

 
Р и с. 10. Варианты рам 
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Таблица 2 
Варианты исходных данных 

 
a b c d F M q1 q2 α β N 

Вар 
N 

Рамы м м м м Н Нм Н/м Н/м град град 
1 1 5 3   1 1 0,3 0,4 30  
2 1 5 3   2 2 0,3 0,4 30  
3 1 5 3   3 3 0,3 0,4 30  
4 2 5 3   1 1 0,3 0,4 45  
5 2 5 3   2 2 0,3 0,4 45  
6 2 5 3   3 3 0,3 0,4 45  
7 3 5 3   1 1 0,3 0,4 30  
8 3 5 3   2 2 0,3 0,4 30  
9 3 5 3   3 3 0,3 0,4 30  

10 4 5 3   1 1 0,3 0,4 45  
11 4 5 3   2 2 0,3 0,4 45  
12 4 5 3   3 3 0,3 0,4 45  
13 5 5 3 2,5  1 1 0,3 0,4 60 60 
14 5 5 3 2,5  2 2 0,3 0,40 60 60 
15 5 5 3 2,5  3 3 0,3 0,4 60 60 
16 6 5 3 2,5  1 1 0,3 0,4 45 45 
17 6 5 3 2,5  2 2 0,3 0,4 45 45 
18 6 5 3 2,5  3 3 0,3 0,4 45 45 
19 7 5 3 2,5  1 1 0,3 0,4 60  
20 7 5 3 2,5  2 2 0,3 0,4 60  
21 7 5 3 2,5  3 3 0,3 0,4 60  
22 8 5 3 2,5  1 1 0,3 0,4 45 45 
23 8 5 3 2,5  2 2 0,3 0,4 45 45 
24 8 5 3 2,5  3 3 0,3 0,4 45 45 
25 9 5 3 2,5 1,5 1 1 0,3 0,4 60  
26 9 5 3 2,5 1,5 2 2 0,3 0,4 60  
27 9 5 3 2,5 1,5 3 3 0,3 0,4 60  
28 10 5 3 2,5 2,5 1 1 0,3 0,4 45 60 
29 10 5 3 2,5 2,5 2 2 0,3 0,4 45 60 
30 10 5 3 2,5 2,5 3 3 0,3 0,4 45 60 
31 11 5 3   1 1 0,3 0,4 30  
32 11 5 3   2 2 0,3 0,4 30  
33 11 5 3   3 3 0,3 0,4 30  
34 12 5 3   1 1 0,3 0,4 30  
35 12 5 3   2 2 0,3 0,4 30  
36 12 5 3   3 3 0,3 0,4 30  
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КОНТРОЛЬНЫЕ ВОПРОСЫ 

 
1. Какая конструкция называется балкой? 
2. Какие деформации имеет балка? 
3. Какая конструкция называется рамой? 
4. Какие деформации имеет рама?  
5. Цель статического прочностного (structural static) анализа балок и рам? 
6. Какие исходные данные необходимы для статического прочностного анализа 

балок и рам? 
7. Основные идеи метода конечных элементов (МКЭ)? 
8. Какой конечный элемент используется для моделирования балок и рам? 
9. Степени свободы узлов стержневых элементов? 
10. Узловые силы стержневых элементов? 
11. Основные операции (команды) моделирования рамы в препроцессоре? 
12. Основные операции моделирования рамы в процессоре-решателе? 
13. Основные операции моделирования рамы в постпроцессоре? 
14. Что такое «реакции опор»? 
15. Что такое «напряжения»? 
16. Что такое «эквивалентные напряжения»? 
17. Как определяется опасное сечение рамы? 
18. Какова особенность распределения продольных нормальных напряжений в     

опасном сечении рамы? 
19. Что такое эпюры продольных сил и изгибающих моментов? 
20. Почему в опорах А и В рамы изгибающие моменты равны нулю? 
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